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1 Introduction

This document describes the ZSSC3218 Evaluation Kit, including the hardware components, the product-specific
configuration, the ZSSC3218 Evaluation Software, and its installation. The software is designed for Windows®-
based operating systems to communicate with the ZSSC3218 Evaluation Kit via a USB connection on the user’s
computer, which functions as a master.

2 Evaluation Kit Overview

The ZSSC3218 Evaluation Kit includes the following hardware components as illustrated in the pink-shaded block
in Figure 2.1:

e ZSSC3218 Communication Board (CB), V1.1

e ZSSC3218 Evaluation Board (EB)

e SSC Sensor Replacement Board (SRB)

e Ribbon cable for the connection between the boards (14 pin)
e 57ZSSC3218 IC samples in a PQFN24 package (DUT)

e USB cable for the connection to a PC

Figure 2.1 ZSSC3218 Evaluation Kit Overview
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To ensure that users have the most current software revision, the ZSSC3218 Evaluation Software and the
documentation are available for download from www.IDT.com/ZSSC3218KIT.

The Evaluation Board provides a connection for a sensor replacement device (e.g., the SRB) or a user sensor
module and an alternative 4-pad solder connection for a soldering a sensor on the Evaluation Board. Note: Only
one connection can be used at a time.

Schematics for the Communication Board are provided in Appendix A. Schematics for the Evaluation Board are in
Appendix B.

2.1. Installing the Software

The ZSSC3218 Evaluation Kit uses an FDTI controller on the Communication Board to handle the USB protocol,
translate communications, and synchronize communications with the I*C™* and/or SPI interface.

2.1.1. Installing the USB Drivers

Before installing the ZSSC3218 Evaluation Software, the USB drivers for the FTDI device must be installed.
Download the drivers and corresponding installation guides from www.ftdichip.com/Drivers/D2XX.htm. The
Evaluation Software accesses the FTDI controller through the D2XX DLL. The drivers will not affect the operation
of any other USB peripherals. For installation of the drivers, the user’s system must meet these requirements:

x86-compatible PC

64 MB RAM

Hard drive with 20MB free space

USB port

Windows® 2000/XP/Vista/Windows® 7/Windows® 8

Refer to http://www.ftdichip.com/Support/Documents/InstallGuides.htm (see section 6) for instructions on
installing the correct driver.

2.1.2. Installing ZSSC3218 Evaluation Software

Follow these instructions to install the ZSSC3218 Evaluation Software on the user's PC hard drive. After
unzipping the downloaded ZSSC3218 Evaluation Software zip file, navigate to the directory ZSSC3218 EV
SW_vXpxx. (Note: Xpxx refers to the latest version number.) Double click on the setup.exe file, and follow the
resulting standard installation instructions, entering installation paths and identification as needed. If the default
settings have been used, the software automatically completes the installation and creates an access link under
Start > All Programs > ZMDI > ZSSC3218 Evaluation.

* |°C™ is a trademark of NXP.

© 2019 Renesas Electronics Corporation 5 April 1, 2016
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3 Evaluation Kit Hardware

The kit hardware consists primarily of two circuit boards: the ZSSC3218 Communication Board and the
ZSSC3218 Evaluation Board. They are connected via the 14-pin ribbon cable. The Communication Board has a
USB interface for the connection to the user’s computer. The Evaluation Board has a PQFN24 socket where the
sample IC (a.k.a. the DUT) must be inserted.

3.1. Communication Board

The ZSSC3218 Communication Board has devices mounted on both sides. The components on the top side of
the board generate a stable supply voltage and an optional external programming voltage. See Figure 3.1.

There is a pin header (K10) for using a jumper to select either the I°C™ or SPI communication protocol for
communication with the DUT in the socket on the Evaluation Board (see section 3.3). Jumpers K7, K9, and K11
are not applicable, and the settings shown in Figure 3.1 must not be changed. The ribbon cable connector that
connects the Communication Board to the Evaluation Board provides access to all communication signals; e.g.,
for an oscilloscope probe.

A metal potentiometer can be used to adjust the supply voltage in the typical range from 1.7V to 3.8V. Its initial
adjustment on delivery provides a voltage VDD = 2.0V to 2.2V. The intensity of the adjacent LED is proportional to
the supply voltage.

See section 3.5 for an explanation of the K5 voltage setting.

Figure 3.1 Components on the Top Side of the Communication Board
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On the bottom side of the Communication Board, the largest IC is the FTDI microcontroller for protocol handling.
There are also voltage regulators for the two variable voltages (VDD and VPP) and level shifters for communi-
cation signals.

Figure 3.2 Components on the Bottom Side of the Communication Board
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3.2. Evaluation Board

The Evaluation Board provides two alternatives for connecting a sensor or a sensor replacement device: via a 16-
pin square sensor connection terminal (K7) or by soldering a sensor with 4 pads on it to an SMD footprint (see
Figure 3.3).

The pin header blocks (K1 and K2 with 4 pins x 9 pins) adjacent to the DUT socket allow using a 2-pin jumper to
connect signal lines of the DUT (either of the 2 middle pins in each row of each header block) to either VSS (the
GND trace pin adjacent to the DUT) or VDD (the outer V_TGT trace pin, which is the supply voltage generated
from the Communication Board).

Note: Refer to the schematic in Appendix B and to the pin assignments for the PQFN24 in the ZSSC3218 Data
Sheet to correlate the labels for the K1 and K2 lines with the actual ZSSC3218 pins.

To connect the proper supply required for the DUT, use the red jumper to connect the DUT’s VDD signal line to
the V_TGT line as shown in Figure 3.3. Use the blue jumper to connect the DUT’s VSS pin to the GND line.

Figure 3.3 ZSSC3218 Evaluation Board

) . . Full- Featured
8-Pin, 6-Pin, 4-Pin 14-Pin Connector
Connectors (K10)

(K6, K5, K3)
VDD Connection
Jumper
VSS Connection K2
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A Possible Connection
Sensor Terminal (K7)
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3.2.1. IC Orientation for ZSSC3218 Socket

Ensure that the DUT is properly installed in the PQFN package socket before applying power to the kit. Figure 3.4
shows the proper orientation for the DUT in the socket.

Figure 3.4 Orientation of the PQFN in the Socket

Pin 1 mark board/IC package

3.3. Interface Choice

Depending on the desired communication protocol the following hardware and software settings are necessary.
Jumpers on the Communication Board must be set as shown in Figure 3.5 depending on the interface selection.
Refer to the schematics in Appendix A and Appendix B for more details about the signal path.

Figure 3.5 Communication Interface Choice
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On the Evaluation Board no jumpers are needed. The DUT recognizes the communication interface by the signal
activities on the respective signal lines. After the power-up sequence, activity on the MOSI/SDA, SCLK/SCL, and
SS lines is generated by the Evaluation Software, which must match the jumper setting on the Communication
Board. The default interface of the Evaluation Software is I°C™. The interface can be changed to SPI via the
Menu bar > Interface Setup > Interface Type > SPI.

« If the first command is an I°C™ command and SS pin has been inactive until receiving of this command,
the DUT enters the 1°C™ mode.

o If the first interface action is to set the SS pin to active (whether it is active-high or active-low depends on
the SS_polarity setting stored in register 02,cx in the DUT’s memory), then the DUT enters SPI mode.

3.4. Connectors

The connectors on the CB and EB are labeled. When the ribbon cable is connected (see proper orientation in
Figure 2.1), it provides all possible signals between the microcontroller on the CB and the DUT on the EB. The
minimum signals required are VDD, VSS, SDA, and SCL; these lines can provide all options for measurements
and I°C™ communication.

Note: The signal names on the CB and EB do not match for some signals; nevertheless the actual signals are
provided at the same pins at the corresponding connectors.

Figure 3.6 shows the pin assignment for the available connectors at the CB.

Figure 3.6 Connectors and the Pin Assignments at the CB
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MA CE OU -3 . ) GPOUT_0
MA CLOCK_OLPT ‘4 ‘4 s GPOUT_1
ss¢_Mos| snz =5 =5 ; GPIN 4
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Figure 3.7 Connectors and the Pin Assignments at EB
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3.5. Supply Voltage

The Evaluation Kit can be powered with an internal or external voltage supply for the DUT on the Evaluation
Board, which must be selected with the jumper on the K5 pin header on the CB (see Figure 3.8). There are no
settings for selecting the supply source on the EB.

3.5.1. Internal Supply Voltage

The internal VDD supply is generated by a regulator circuit on the CB. It can be adjusted with the potentiometer
(see Figure 3.1) in the specified supply voltage range. It is used as the HIGH-level reference for all signals that
are needed for communication with the DUT. If the red jumper on K5 on the CB is positioned as shown in Figure

3.8 (“int” setting), then the DUT on the EB is supplied internally. With this setting, no external voltage input is
needed for the Evaluation Kit.

Figure 3.8 Jumper Settings on Communication Board for Internal Supply Voltage
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3.5.2. External Supply Voltage

An alternative for providing the supply voltage to the DUT is to input an external voltage supply source. Ensure
that the external voltage does not exceed the voltage supply specifications given in the IDT data sheet for the
DUT before connecting to the Evaluation Kit.

To use an external supply, set the K5 jumper as shown in Figure 3.9 (“ext” setting). Connect the external voltage
to the 2-pin V_ext header that is immediately to the right of the K5 jumper with the orientation shown in Figure 3.9.
There are no adjustments for the external voltage on either the CB or EB.

Figure 3.9 Jumper Settings on the Communication Board for the External Supply Voltage

VSS_ext
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4  Evaluation Kit Software

When the ZSSC3218 Evaluation Software (GUI) is activated, the left side of the first screen is the General tab,
which provides the basic communication status (see Figure 4.1). The largest section of the screen is the main
graph area on the right, which is for displaying the measurement results over time. The data scale for temperature
output is on the right side of the main graph; the scale for bridge measurements is on the left. The x-axis
represents the number of measurement points at a given value in a run. Both y-axes display the corresponding
bridge/temperature value in a format selectable by the user.

Figure 4.1 GUI View after Opening the Evaluation Software
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4.1. Top Menu GUI Controls

At the top of the GUI screen is a banner for GUI controls that are always available. These include display fields at
the left for real-time single bridge and temperature measurement results. There are also additional controls in the
top and bottom sections of the screen as described in Table 4.1.

Table 4.1 Basic GUI Controls

Control Unit

Description

Port button

The Port button allows closing and opening the USB communication port. This is useful
for making hardware changes (e.g., switching the DUT or jumper settings) without
exiting the GUI. It also indicates the current status. The button is green only if proper
communication has been established.

Status display field

The Status display field shows information related to the current GUI operation; e.qg., if
calculated coefficients exceed the defined limits, the Status field displays the error.

Power
Cn
off

Power On/Off icon

The Power On/Off icon indicates whether the supply voltage is applied to the DUT in
the socket on the EB.

Reset

The Reset button triggers a HIGH-LOW-HIGH-transition (active-low reset) at the RES
pin. Clicking this button completely resets the DUT.

[ average values

average values checkbox

Select average length

1 | | |
4 8 16 32

Select average length slider

Checking the average values checkbox activates averaging of the measurement
results. The Select average length slider determines the number of measurements that
are taken to calculate the average result, which will then be displayed in the display
fields for measurement results and on the main graph. Averaging extends the time until
the results appear in the GUI by the factor of adjusted average values. The results are
displayed in color instead of black font.

Bridge graph  Temp. graph
1 1 1 I 1 1
off [N} [%] Off [N] [deg.C]

Bridge graph / Temp. graph
slider bars

The output type for measurement results can be chosen or the associated graph can
be switched off with the Bridge graph and Temp graph slider bars. Raw measurements
are only provided in counts. After calibration, the °C and % displays are available.

[N] — Displays measurement results in counts.

[deg. C] — Displays measurement results in degrees Celsius. This option is only
available in Normal Mode where the measurements are linearized by coefficients.

[%] — Shows measurement results in percent in relation to full-scale output (FSO =
2"R-1, where R is the ADC resolution in bit).

Off — No display of results for the associated graph.

© 2019 Renesas Electronics Corporation
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Control Unit Description

This button activates a cyclic bridge and/or temperature measurement. The
measurement mode is defined by the Raw /DSP measurement mode slider to the left
of this button. See Table 4.5 for a description of the raw data measurement mode and
the digital signal processing (DSP) signal conditioning measurement mode.

In DSP measurement mode, it is also possible to check the cyclic checkbox on the top
of the GUI. This will start a loop of full-measurement cycles, where the ZSSC3218
internally triggers the measurements as it is configured in the Interface Configuration
register (02nex), which is described in section 4.3.3.

Start

This slider selects either the raw data measurement mode or the DSP signal
conditioning measurement mode. Raw measurements must be configured either via
Raw /DSP measurement | e EXTERNAL CONFIGURATION section on the EXT tab (see section 4.7) in the

mode slider panel on the left or by directly writing a configuration into the selected SM_configX
register (see the ZSSC3218 Data Sheet for details). The raw data output provides the
results directly after the analog-to-digital conversion (ADC).

Yo The DSP position selects the configuration from the selected SM_configX register for
Raw Dse the measurement. The digital result after the ADC will be then processed using the
calculated coefficients. This measurement mode will provide valid results only after a
valid calibration of the ZSSC3218.

This checkbox sets the measurement command to Measure_Cyclic (ABunex), which
executes a continuous full measurement cycle (AZSM, SM, AZTM and TM). In this
mode, the ZSSC3218 internally triggers the measurements, so it is only necessary to
periodically read the output registers.

I eyclic Note: Using cyclic measurements results in a continuous BUSY status (see “Status?”
below). The bit is set to ‘1’ until the STOP_CYC (BFnex) command is sent. Cyclic
measurements can have different properties; the configuration can be set in the
Interface Configuration register 02ex.

Cyclic checkbox

This entry field is read by the software and used to define the delay after the
measurement command before sending the reading request. It can be changed by the
user. This period is defined by the conversion time of the ADC, the ZSSC3218
processing time, and the communication time between master and slave. Depending
Conversion Time [ms] on the resolution settings, the conversion time can vary significantly. The default value

30 of 30ms suffices to establish an auto-zero-corrected measurement with the default 18-
bit resolution for the external sensor and 16-hit resolution for the internal temperature
measurement. The conversion time can be derived from the ADC conversion time
specifications given in the ZSSC3218 Data Sheet.

Conversion Time

Status ? This button requests and reads the ZSSC3218's status byte and displays the result on
us < the LEDs on the General tab.

Reads the complete contents of the multiple-time programmable (MTP) memory of the
Read MTP (all) ZSSC3218. The decoded basic bridge configuration and the I’C™ address are
displayed on the General tab.

This button activates writing to the MTP of the ZSSC3218. It writes only the addresses
for which the content is shown in red font on the MTP tab (see section 4.6). In addition
to using the automatic data transfer from the Calibration tab and General tab, users
Write MTP {sel) can also edit the values by double-clicking on the value on the MTP tab page. The
ZSSC3218 must be in Command Mode (CM) in order to write to the MTP; therefore the
software performs a power-on >power-off >Start CM sequence in the background.
After the write operation, the ZSSC3218 will be set into Normal Mode again.

i |
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4.2. Measurement Color Code

Bridge and temperature results are displayed in different colors. Different colors are also used for single and
averaged measurement results as defined in Table 4.2

Table 4.2 Color Code for Bridge and Temperature Results

Pink Single bridge measurement.

Light Blue Single temperature measurement.

Blue Averaged bridge measurement.
Green Averaged temperature measurement.
Red Invalid measurement result. This could be due to a Conversion Time that is too short. In this case, bit 5 in

the status byte is set to ‘1’ and the Busy virtual LED on the General tab turns on. Another reason for an

invalid measurement result could be if saturation of the arithmetic logic unit (ALU) is detected. In this case,
the Saturation LED turns on.

4.3. GUI Menu Bar
Figure 4.2 shows the submenu, dialog, and informational items accessible via the top GUI menu bar.

Figure 4.2 Structure of the GUI Menu Bar

File Scan|2C address! Interface Setup! Infol
= Software Information |
-— ®
Save MTP Config
Load MTF Config
Measurement Log The Analog Mixed Signal Company
. . - e | ZMD AG
Communication Log 2 Interface Setup Grenzstrasse 28
01109 Dresden
. X Germany
Interface Type  Interface Speed Interrupt Setup Cycle Period!
2w 400KHz ¥ EOC - na. v
12c SPI
12C Slave Address SPI Clock ldle State
00 Low i
12C Type Chip Enable Polarity SPI Data Qutput Edge
Mormal ¥ [ LowActive ~ ‘ [ High = Low r|
Interrupt tresholds 0 0
Treshold 1 Treshold 2
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4.3.1. Save/Load MTP Register Contents

Initially, the customer memory pages are empty. If an identical memory configuration is needed for multiple ICs, it
is possible to save a given setup as a template. When the required MTP content is present in the MTP tab, select
File > Save MTP Config. The configuration file is created with an .eep extension, and it contains one decimal
value for each MTP address in each row.

To load a configuration file, select File > Load MTP Config. Note: The decimal values will be automatically dis-
played as hexadecimal values in the MTP tab. The loaded configuration data is displayed in red font in the MTP
tab and can be written into the memory.

4.3.2. Scan I’C™ Bus via the Scan 12C address! Feature

Another feature provided in the menu bar is the ability to scan the I°C™ bus to determine the I°C™ address of the
ZS5SC3218. Selecting Scan 12C address triggers the scan during which the ZSSC3218 status is requested for
each address ranging from 00pex to 7Fpex. When an I’°C™ address is acknowledged by the ZSSC3218, the scan
stops, and this address is used for further communication during the current GUI session. The results of the scan
are indicated in the status window:

« Status window message for a successful ’C™ scan: Valid 12C address found: OxXX!
« Status window message for an I°C™ scan without slave acknowledge: No valid 12C address found!

The I’C™ address information is lost if the GUI or the communication port is closed. Communication to the
ZSSC3218 with an I°C™ address other than 00,ex can also be established by entering it manually in the Interface
Setup dialog accessible via the top menu bar by selecting Interface Setup and entering the hexadecimal address
in the 12C Slave Address field.

4.3.3. Interface Setup Dialog

The interface setup dialog allows the general choice between the I°C™ and the SPI interface. After an interface is
selected, the software generates the corresponding data frame structure which is then recognized by the
ZS5SC3218. All parameters in the upper row (Interface Type, Interface Speed, Interrupt Setup, and Cycle Period)
and the 12C/SPI specific settings in the corresponding section are parameters from the Interface Configuration
register (02yex). The lower part of the window displays the selectable lower and upper threshold values for the
interrupt configuration (see ZSSC3218 Data Sheet for details). Enter the values in the decimal representation.

Modifications entered in the dialog are valid for further communication after this window is closed. To save the
changes in the ZSSC3218's memory, adjust the parameters as needed and click the Copy IF settings to memory
button to transfer it to the MTP tab in the GUI. As a result, the registers 02,ex (Interface Configuration) and/or
registers 13pex, 14nex, and 154 (interrupt thresholds) appear red if their content changed. Then click the Write
MTP (sel) button on the MTP tab to write the new content into the memory.
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4.4. GUI-General Tab

Table 4.3 General Tab —Displays and Controls

Control / Display Unit

Description

IC Communication Status

i Powered =l Busy
=l CMD Mode . Memory Error
Bl Test Mode Bl Saturation

Detected Interface: 12C

The communication status section evaluates the status byte information sent from the
sample. It provides following information via the virtual LEDs:

Powered indicates if the device is powered. If the LED is off, it does not automatically
mean that VDD is not supplied. For example, the LED will be off if the l2c™
communication is attempted with an I’C™ address different from the address
programmed in the ZSSC3218’s memory.

CMD Mode shows whether the ZSSC3218 is in Command Mode.
Test Mode shows whether the ZSSC3218 is in Test Mode (not intended for users)

Busy indicates if processing of the last command is finished. If it is, the LED is off.
Note: the LED will be on continuously if the ZSSC3218 is in a cyclical measurement
mode.

Memory Error displays whether the checksum-based integrity check passed or failed.
In the default state of the kit, this LED should be on. Recommended approach: After
writing memory data (e.g., bridge configuration, coefficients), write the signature of the
memory contents via the Write Checksum to MTP (register 0x39) button on the MTP
tab. After a subsequent power-on-reset sequence, the integrity check should pass and
the LED should turn off.

Saturation: This LED is on if the DSP core saturates; e.g., if the internal signal
correction result exceeds the limits of the internal arithmetic logic unit (ALU).

log communication Checkbox

[T log communication

For some purposes such as debugging or documentation, it is helpful to log the
master-slave communication. To record this data, activate this checkbox, which results
in a dialog window for selecting the name and location for a .txt file where this informa-
tion will be written. After the .txt log file is set up, it can be opened via the menu bar:
File > Communication Log.

Interface Configuration

12C Slave ADR 00

After reading the MTP, the display shows the I°C™ address that is saved in the
memory. If a new address is entered in the window and the Copy Measurement
Settings to MTP button is clicked, the new value is shown in red color on the MTP tab.

-1 SMCONFIG 2 =

Depending on which configuration register is selected, LED 1 or 2 on the General tab
is green. This information is obtained from the ZSSC3218’s status byte where bit 1
(Config Setup) identifies the valid configuration register. Command BOnex selects the
SM_configl register for sensor measurement configuration; command Blnex selects
the SM_config2 register. See Figure 4.3 for further details.

© 2019 Renesas Electronics Corporation
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Control / Display Unit Description
The Sensor Configuration area provides settings for the analog signal path and
Sensor Configuration analog-to-digital conversion. The drop-down menus contain the available setting
values.
Sensor Configuration . i
_ Changing the parameter values here does not automatically apply them to measure-
| Gan | 4z 7 ments. It is possible to apply the adjusted settings and use them for raw data
Ry postive it collection. There are different commands for performing raw measurements. Some of
ADC Resclution 12 Bit = the commands use the configuration from the SM_config register (commands AOnex,
Themopils Enable No bt A24ex); others (Aluex, A3nex) are configured via the interface. For a full description of
Offsst Shit 000 - raw measurement commands, refer to section 4.7.1.
Copy Measurement Settings for For configgrgﬁon via the intgrface, cIick.on the. Copy Measurement Settings.for Raw
Raw Data Acquisition Data Acquisition button, which automatically displays the EXT tab (see section 4.7)
- and transfers the present settings to the external configuration section.
Copy Measurement Settings
to MTP Tab The Copy Measurement Settings to MTP Tab button copies the present settings to the

MTP tab. The settings can then be written to the MTP memory (see section 4.6).

4.4.1. Using Two Configurations for One Sensor

For users who consider using one sensor for different applications, there are two configuration registers available.
This might be useful, e.g., for thermopile applications where two different object temperature ranges should be
covered with only one sensor-ZSSC3218 combination, in which case it is primarily the analog gain parameter that
will have different values. The ZSSC3218 supports this type of function. The selection of the SM_configX register
is not mandatory. If no active SM_configX selection is executed, SM_configl is used for configuration. To apply
the configuration of the second configuration register, it is necessary to send a command that selects it. Once a
register is selected, its configuration is valid as long as VDD is on or until there is a reset or a command to select
the other register. The following graph shows the possibilities for handling two configurations.

Figure 4.3 Selection of the SM_configl or SM_config2 Register

( Power On )
4 : B\

Select SM_configl or
Y SM_config2 Register
Command: 0xB0 / 0xB1

/ ) A
Gnd Measurement Comma@

A 4

(o)
C )

7N

A 4

Power Off
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4.5. Data Logging

The ZSSC3218 Evaluation Kit software provides the option to log measurement and communication data as
described in Table 4.1 and Table 4.3.

45.1. Communication Log

Communication with the ZSSC3218 can be logged for both the I°C™ and SPI interface. Click on the log
communication checkbox on the General tab to activate recording the data stream. Choose a file path for which
the user has writing permission for storing the log file. Open the log file via the top menu bar: File >
Communication Log. The resulting text file is an ASCII file that can be imported into Microsoft® Excel.

45.1.1. I°C™ Log

Figure 4.4 shows a short example of the I°C™ communication recorded in a log file.

Figure 4.4 I°C™ Communication Example

log I2C interface...

data frame 00 a3 0b 26 end
data frame 01 44 38c 87 O end
data frame 00 a& 00 OO end
data frame 01 44 cb 1b 80 end
log end

The log file maps only the transferred data, not the specific frame conditions for I°C™, such as START or STOP
conditions or acknowledges. Communication commands that are not available to the user are not logged. This
also applies to the SPI communication log.

By default, the READ data from the slave has a 4, 5, or 8 byte structure. In the example shown in Figure 4.4, a
raw bridge measurement is done in two steps:

Figure 4.4 shows an example for a raw bridge and temperature measurement sequence:

e Raw bridge measurement (A3pex). Sent to the device with the I°C™ address 00pex, With configuration
transmitted in the following bytes after the command (via interface). The next row shows the read data
frame from the slave to master.

e Raw temperature measurement (A6yex). Sent to the device with the I’C™ address 00,cx. This command
triggers the ZSSC3218 to obtain the measurement configuration from the corresponding configuration
register. Thus the data that comes after the command byte does not have any impact on the
measurement processing. In the next row the ZSSC3218 is providing status and measurement result.

The I’C™ interface properties correspond to the NXP I°C™ bus specification. For the [>’c™ log example data, the
sections of the data frame structure are explained in Figure 4.5. In this illustration for communication frames,
START conditions are indicated with S; STOP conditions are shown as P; and acknowledges are shown with A.
For information about communication frame structure, see the data sheet (see section 3.5.3.).
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Figure 4.5 I°C™ Communication Structure for Example Entry in Communication Log

Master transmits command addressed to ZSSC3218 slave receiver with 7-bit address 00
Data frame in hexadecimal.

<15:8= <=7:0=

00Ex Obyeyx 26ipEx

%G Address Comman Config MSE Config LSB
0000 0000 0000 1011 00100110  end
|3 SlaveAddr | 0 |A| Command ‘A‘ i I ‘A| il |n| P‘

write
bit

Master reads data returned from ZSSC3218 slave receiver

Data frame in hexadecimal:

01 HEx BTvex E0nex
I*C Address. | Status Data MSE Data [15:8] Data Lse |
0000 000 1 1000 1100 1000 0111 00 0000 end
SensorDat SensorDat SensorDat
S| SlaveAddr | 1| A|  Status Al Toomes | Tzimee Al T <70s NP
|
|
read

bit

I:l from master to slave START condition acknowledge
I:I from slave to maste